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Chapter 1 Device Introduction 
Thanks for purchasing AVerMedia’s product. The table below lists an overview of the product you 
purchased. From this table, you can quickly learn about your product features and know which chapter 
you need to read. Please do read this table before using AVerTV 6 application. 

Product Name AVerTV MCE 116 Plus 

Model No. M116 

TV System � Digital TV (� DVB-T � ATSC � DVB-S) 

 Analog TV (  NTSC  PAL  SECAM) 

Audio Mode  Stereo  Mono  SAP 

FM Radio  Support  � Not Support 

Remote Control   Support (� Model 1   Model 2) 

� Not Support  

External Signal 
Source 

 S-Video  Composite 

Others  Teletext  � MHEG-5  

� EPG   iEPG 

 Closed Caption  � Digital Subtitle 

Reference Chapter  Chapter 1 

 Chapter 2 

 Chapter 3 ( 3.1-3.4 3.5.2 3.6-3.12) 

 Chapter 4 ( 4.1 4.4-4.13) 

 Chapter 5 

 Chapter 6 

 Chapter 7 

 Chapter 8  

 Chapter 9 ( 9.2) 

 Chapter 10 

 Chapter 11 

 Chapter 12 

Note  
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Chapter 2 AVerTV 6 Introduction 
Now, with this product, you can watch TV, listen to the radio, record your favorite programs and 
enjoy other features on your PC. Turn your computer system into a real multimedia entertainment 
center. 

You’ll never miss your favorite ball games, soaps or game shows anymore because the TimeShift 
function performs background recording of a TV program. This means you can return and watch from 
the part of the program where you left off.  

To enjoy high quality TV or radio programs, AVerMedia® product is your best choice.  

Please be noted that the functions or the remote control mentioned in this manual may vary depending 
on the product you purchase and the area you live. 



 

Chapter 3 Introducing the AVerTV Application 
The AVerTV 6 application allows you to watch TV or video, and record still or motion video 
on your PC while you work on your computer. 

3.1 Launching the AVerTV 6 Application 
Run the AVerTV 6 application from the Programs menu. 

  

Quick TV Launcher
 

To run the application, click Start, point to Programs, choose AVerMedia, AVerTV 6, and 

then click AVerTV 6. Another way is to double-click the AVerTV 6 program icon “ ”on 
the desktop. Or, you can double-click the AVerQuick launcher located at the lower right 
corner of the screen. 

 Note: AVerQuick launcher is important for both of the remote control and the Scheduler. 
If it is not activated, the remote control feature is automatically disabled and the 
Scheduler will not perform any preset schedules. 

3.2 Running the AVerTV 6 application for the first time 
If this is your first time running the application, the Setup dialog box will appear to prompt 
you to scan for channels. (For details, please refer to the section Scanning Channels). 

1. Choose your desired signal input (Digital TV, Analog TV or FM Radio) on the left pane 
of the Setup dialog box. 

 Note: Before choosing the signal input, please make sure that your country/region is 
correct. For more information, please refer to “Scanning Channels” in Chapter 3. 

3 



 

2. Then you need to select the TV option to search for air channels, or select CATV to scan 
for cable channels if your choice is “Analog TV” in step 1. 

 

3. Click New and the Program List dialog box will appear. Type in the desirable name and 
click OK. 

 

4. Click Program Scan to search for available channels/programs in your area. 

 
5. After scanning, the active TV channels will be listed inside the box. Click Apply to save 

the scanned channels.  

 Note: Digital channels that are in red text indicate they are locked channels (eg. Adult channels).  

6. To exit the current dialog box, click OK. 
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7. If you choose FM Radio or Digital TV in step 1, just repeat step 3-6 to complete the 
program scanning. 



 

3.3 Introducing the User Interface 
The TV monitor allows you to watch live TV or video. 

 
1 Panel On / Off 8 Channel Up/Down 
2 Playback Seek Slider 9 Resize Window 
3 Play / Pause 10 Show / Hide Video Frame 
4 Stop 11 Minimize 
5 TimeShift 12 Full Screen 
6 Record 13 Exit 
7 Volume   
The Control Panel provides button controls for selecting channels, adjusting volume, 
capturing images, and more. It has a panel display that shows the current channel number and 
channel name.  

To display or hide the Control Panel, click the button  located at the lower left corner of 
the TV Monitor.  
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3.4 The Control Panel 

 
(This picture is only for reference) 

The table below describes the functions of the buttons on the Control Panel. 

 BUTTON FUNCTION 
1 Signal Status /  

Repeat Play Status 

TV/Radio mode: Right click on the info area of the control panel 
to switch signal sources. 
Playback mode: Right click on the info area of the control panel 
and enable the Repeat function. The system will continuously 
playback the files in the playlist. 

2 Signal Strength Display signal strength. 

3 Backward Move backward in intervals. 

4 Channel Loop Return to previously accessed channel. 

5 16-Channel Preview  Display 16 consecutive TV channels on the TV Monitor 
window. 

6 Channel Up/ Down Move up/down the channel list 

7 Mute Turn off the sound. 

8 Setup Allows you to: 
*Autoscan channels. 
*Create channel groups. 
*Configure snapshot settings. 
*Customize record settings. 
*Customize the TimeShift function. 

9 Teletext View Teletext (PAL/SECAM) / Closed Caption (NTSC) 
information. 

10 EPG View EPG information (This function is only available for 
digital TV). 

11 Snapshot Capture a single image or a sequence of images. 

12 Forward Skip forward in intervals. 

13 Always on Top Make the TV monitor float over the top of other program 
windows. 
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14 Full Screen Show TV/Video programs in full screen. 

15 Program List Display the program list and adjust color, volume and so on. 

16 Audio Mode Switch between available audio modes. 

17 Scheduler Display Scheduler dialog box. 

18 Play List Create a playlist of video files to playback. 

19 Show/ Hide Numeric Panel Toggle between displaying or hiding the Numeric Panel. 

20 Radio Source Switch between FM radio and DVB-T radio. (Only access to 
DVB-T Radio Broadcast, not Digital Audio Broadcast system.) 

21 Change Video Source Switch between analog TV, digital TV, or S-video. 

22 Record Record the current TV show. 

23 TimeShift / Pause Performs background recording of the live TV program. This 
function lets you view the recorded parts, while at the same time, 
recording is in progress. / Freeze the playback temporarily. 

24 Next File Play the next file in the playlist. 

25 Previous File Play the previous file in the playlist. 

26 Stop Stop the playback, recording, TimeShift, etc. 

27 Play / Pause Playback recorded video files. / Freeze the playback temporarily.

28 Volume Control Increase/decrease the volume level. 

29 Help View User’s Manual. 

30 Numeric Buttons Select channels/programs. 



 

3.5 Remote Control 

You can use remote control to turn on/off the programs, select channels, adjust volume and so 
on. Please be noted that you have activated Quick TV.  

3.5.1 Remote Control Buttons (Model 1) 

1
2

3

4

5

6

7

 

Button Description 
1. Power Turn on/off the application 
2. VOL +/- Volume up/down. 
3. Source Switch between available signal sources. 
4. Numeric Buttons Select a TV channel. 
5. MUTE Turn on/off the sound. 
6. CH ▲/▼ Go up or down to the next active channel. 
7. CH RTN Go to the previously selected channel. 
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3.5.2 Remote Control Buttons (Model 2) 

 

Button Description 
1. POWER Turn on/off the application. 
2. NUMERIC BUTTONS - Select a TV channel. 

- Under the 16-Channel Preview mode, use ← ↑ → ↓ to 
highlight the intended channel. 

3. CH RTN Go to the previously selected channel. 
4. 16-CH PREV 16-Channel Preview. 
5. VOL▲/▼ Volume up/down. 
6. FULL SCREEN Display TV in full screen. 
7. AUDIO Switch between available audio modes. 
8. ► (Play) Play the last recorded or played file. 
9. ■ (Stop) - End the playback or recording. 

- End the TimeShift mode and return to real-time TV or Radio
mode. 

10.  (Forward) - Advance the playback. 
- Jump to the Teletext page of the corresponding color 

according to this button. 
11. SLEEP  - Go to the next file in the playlist. 

- Set the time to put your computer in Stand By or Hibernate 
mode. 

- Jump to the Teletext page of the corresponding color 
according to this button. 

12. MENU Display or hide the Control Panel. 

13. EPG Launch the Electronic Programme Guide. 

14. WAKE UP 
 

- Go to the previous file in the playlist. 
- Set the time to bring your computer out of Stand By or 

Hibernate mode. 
- Jump to the Teletext page of the corresponding color 

according to this button. 
15. TELETEXT View Teletext (PAL/SECAM) / Closed Caption (NTSC) 

information 
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16. TIMESHIFT /PAUSE - Freeze the playback. 
- Switch from real-time TV or Radio to TimeShift mode. 

17.  (Rewind) - Rewind the playback. 
- Jump to the Teletext page of the corresponding color 

according to this button. 
18. ● (Record) Switch to DVR mode and record the current program or video 

into your hard drive. 
19. MUTE Turn on/off the sound. 

20. CH ▲/▼ Go up or down to the next active channel. 

21. SNAPSHOT Capture the on-screen image to a bitmap file. 

22. DISPLAY Display information. 

23. SOURCE Switch between available signal source. 
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3.5.3 Remote Control Buttons (Model 3) 

 

Button Description 

1.Power Turn on/off the application 
2.Numeric Buttons - Select a TV channel. 

- Under the 16-channel preview mode, use↑↓← → to highlight the intended 
channel. 

3.CH RTN Go to the previously selected channel. 
4.16-CH PREV 16-channel preview. 
5. VOL▲/▼ Increase/decrease the volume. 
6.FULL SCREEN Display TV or video in full screen. 
7. AUDIO Switch between available audio modes. 
8. ► (Play) Play the last recorded or played file. 
9. ■ (Stop) - End the playback or recording. 

- End the TimeShift mode and return to real-time TV or FM mode. 
10.  (Forward) - Advance the playback. 

- Jump to the Teletext page of the corresponding color according to this button. 
11.  (Next File) - Go to the next file in the playlist. 

- Set the time to put your computer in Standby or Hibernate mode. 
- Jump to the Teletext page of the corresponding color according to this button. 

12. AUTOSCAN Display or hide the Control Panel. 
13.  (Previous 
File) 

- Go to the previous file in the playlist. 
- Set the time to bring your computer out of Standby or Hibernate mode. 
- Jump to the Teletext page of the corresponding color according to this button. 

14. TELETEXT View Teletext information. 
15. 
TIMESHIFT/PAUSE 

- Freeze the playback. 
- Switch from real-time TV or FM to Time Shift mode. 

16.  (Rewind) - Rewind the playback. 
- Jump to the Teletext page of the corresponding color according to this button. 

17. ● (Record) Switch to DVR mode and record the current program or video into your hard drive.
18. MUTE Turn on/off the sound. 
19. CH ▲/▼ Go up or down to the next active channel. 
20. SNAPSHOT Capture the on-screen image to a bitmap file. 
21. DISPLAY Display information. 
22. TV/FM Switch between available signal sources. 
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3.6 Resizing the TV Monitor Window 
To enlarge or reduce the size of the TV Monitor window, click and drag the lower right 
corner of the window. 

Double-click the TV Monitor window to display it in full screen or click the Full Screen 
button  on the Control Panel.  

When in full screen mode, just double-click anywhere on the screen to revert to the normal 
TV window size. 

3.7 Always on Top 
To make the TV monitor window float over the top of 
other program windows, right-click on the TV monitor. 
In the pop-up menu, point to Video and choose Always 
on Top. 
OR,  

Click the Always on Top button  on the Control 
Panel.  
 
 
 

3.8 Setting Windows® Power Options 
This option allows you to put your computer in Stand By or Hibernate mode, power off, exit 
the application or log off from the computer while you are away from the computer. 

 Note: 
Stand By: Stand By is a state in which your monitor and hard disks turn off, so that your 
computer uses less power. 
Hibernate: Hibernation is a state in which your computer shuts down to save power but first 
saves everything in memory on your hard disk. 

Please do the following: 

1. First, Click the Setup button  and in the Setup dialog box, click Miscellaneous icon on 
the left pane. 

2. By default, the system is set to enable the Stand By/Hibernation option. What you have to 
do is to choose the desired power-saving settings. If your computer has a problem with 
coming out of Stand By or Hibernate mode, please clear the Stand By/Hibernate option. 
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3. Then press the Sleep button on the remote control repeatedly to set the execution time. 

OR, 

1. Right-click on the TV monitor, point to Sleep and select the desired mode. 

2. Right-click on the TV monitor again, point to Sleep and choose an execution time. 

 

3. The time setting will be displayed on the TV monitor. For details, please see the 
description below. 

Time setting mode Description 
Sleep 30/60/90/120 Minute(s) Your computer will go into Stand By or Hibernate mode in

30/60/90/120 minutes. 
Now Your computer will go into Stand By or Hibernate mode in 

about 10 seconds. 
Cancel Your computer will return to original settings. 
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 Note: The system will detect if your VGA card supports DXVA. If yes, enable the “DXVA 
Support” to activate the video acceleration of the VGA card. To watch HDTV, it is strongly 
recommended to execute “DXVA Support”. 

 

3.9 Minimize the Application 
To minimize AVerTV application to the system tray (notification area), click the Setup 
button  and in the Setup dialog box, click Miscellaneous icon on the left pane. Then Select 
the Minimize to Tray check box. Or clear the check box to simply minimize the application 
to a taskbar button. 

 

3.10 Change Definitions of the Remote Control Buttons 
1. Click the Setup button  and in the Setup dialog box, click on the Remote Remapping icon on 

the left pane. 

2. To re-define a function for a certain button: 

● Select a desired button and choose a new command from the right pane of the dialog box. 
Then click Assign. 

● From the right pane of the dialog box, drag the desired command and drop it on the remote 
button which you want to change the definition. 



 

 

3. Click Apply to save the settings. 

4. Click Clear All to delete all definitions of the remote control or click Default to revert to the 
factory setting. 

3.11 Customize the Remote Control Source Button 
On the Remote Source Control page, you may customize the remote control “Source” button to switch 
on the selected item.  

1. Click the Setup button  and in the Setup dialog box, click on the Remote Remapping→
Remote Source Control icon on the left pane. 

2. Select the signal source that you want. 

3. Click the UP or DOWN button   at the right side until the selected signal reaches the 
location you desire.  

4. Click Apply to save the settings. Or click Default to revert to the factory setting. 

16 



 

 

3.12 Changing the OSD Attributes 
Click the Setup button  and in the Setup dialog box, click the Personalise icon on the left 
pane. On this page, you can customize the curtain effect, LCD speed or change the appearance 
of the TV monitor and the control panel (Skins). 

 

Click the Setup button  and in the Setup dialog box, click the Personlise → OSD icon on 
the left pane. On this page, you can determine the OSD information, display duration and 
adjust OSD color. Then, click Apply to save the settings. 
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Chapter 4  TV 
In this chapter, we will introduce methods to scan programs, select a TV/Radio program, 
create a group and so on. 

4.1 Analog TV    
4.1.1 Scanning Channels 

If you didn’t complete the channel scanning when you first ran the application, please follow 
these steps to complete this procedure. 

1. Click the Setup button  and in the Setup dialog box, select an available Avermedia device in 
the left pane. 

 Note: 
Make sure that your Country/Region is correct. 
a. First, select an available Avermedia device in the left pane. 
b. From the Region/Country drop-down list, select your country or region. 
c. Click Apply to save the settings. 

 

2. Then select Analog TV. On this page, choose the TV option to search only for air channel 
or select CATV to scan for cable channels. 

3. Click New and the Program List dialog box will appear. Type in the desirable name and 
click OK. 

 

4. Then Click Program Scan to start the scanning process. 
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The application comes with a default frequency table therefore the application will use 
this table to search for active channels/programs. If you want to terminate the searching 
process, just click Stop. 

5. You can check the scanning progress from the progress bar. After scanning, the active 
TV/Radio channels will be listed inside the box. Click Apply to save the scanned channels. 

 

4.1.2 Scanning Channels (For Advanced Users) 

1. Click Advance located at right-lower corner in the Program Information section. Then 
the Advance Program Configuration dialog box will appear. 

 

2. If you don’t want to miss any channels, click All Frequencies Scan. 
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3. When a warning message appears, click Yes to continue the procedure or click No to abort 
this operation. 

4. After scanning, new active channels/programs will be memorized and listed in the left 
pane of the dialog box. 

5. Click Apply to save the scanned channels. 

 Note: Here you can modify the channel name, select the video and audio system. If you 
want to revert to factory setting, simply click Default button. 

4.1.3 Customize Video record settings 

To customize the video record settings, please do the following. 

1. Click the Setup button  and in the Setup dialog box, click on the Analog TV icon on 
the left pane. 

2. Select the Record Format option. 

3. Determine the video file format to use for saving the recorded video file.  

4. You can use the default format or select New to create your own file format.  
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5. Click New and the Format dialog box appears. In the Format dialog box, select the file 
format you want and enter the desired name in the text box. Click Next. 

 

6. In the Video dialog box, you can set the video format and audio format. Click Finish. 
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7. If you want to change the settings of your own file format, click Modify. Or click 
Delete to remove the unwanted file format that you created. 

8. Click Apply to save the setting and click OK to exit the current dialog box. To abort 
this operation, click Cancel. 

 Note: To determine the length of recording and to choose a destination folder in which 
to save the recorded audio, please refer to the section titled Record Settings in Chapter 6. 

Information: 

File Format Description 

MPEG-1 Choose MPEG-1 format for video files that are intended for CD-ROM 
playback on a computer or for Internet transmission. MPEG-1 allows file 
compression and offers VHS quality picture. Just about every system 
available today can play MPEG-1 and does not need special software or 
hardware. 

MPEG-2 Videos compressed using MPEG-2 have extremely high quality pictures 
and full CD-quality sound. Choose MPEG-2 format for video files that are 
intended for DVD-ROM playback on a computer or if you want broadcast 
quality videos. 

VCD When you choose this format, the recorded video file will be saved in 
MPEG-1 format that is compliant with VCD standards. Standard VCD 
frame size and frame rate are 352 x 240 pixels at 29.97 fps for NTSC and 
352 x 288 pixels at 25 fps for PAL. 

SVCD When you choose this format, the recorded video file will be saved in 
MPEG-2 format that is compliant with SVCD standards. Standard SVCD 
frame size and frame rate are 480 x 480 pixels at 29.97 fps for NTSC and 
480 x 576 at 25 fps for PAL. 

DVD When you choose this format, the recorded video file will be saved in 
MPEG-2 format that is compliant with DVD standards. Standard DVD 
frame size and frame rate are 720 x 480 pixels at 29.97 fps for NTSC and 
720 x 576 at 25 fps for PAL. 

AVI AVI is the most common video file format for playback on the computer. 
It can be saved in uncompressed form if you want high quality video, or 
compressed using any of the available codecs if you want to minimize the 
file size. 

WAV A common audio file format for Windows computers. It was created by 
Microsoft and has become a standard PC audio file format.  

iPod A video format base on H.264 standard but has smaller video bit rate. It’s an iPod -
compatible format. 

MP4-H.264 Videos compressed using MPEG-4 standard are two or three times more efficient 
than MPEG-2. This format can be applied to a wide variety of applications or 
networks and systems like HD-DVD, Digital TV, Broadcast and Streaming 
applications. 

WMA An audio file format that is use for content intended for local playback or 
download and play. It provides near-CD quality.  
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WMV WMV stands for Window Media Video, which is defined by Microsoft. This file 
targets audiences with high speed Internet or LAN connections. 

MP3 An audio format compressed with a standard defined by Motion Picture Experts 
Group offers near-CD quality sound. 

4.1.4 Fine Tuning Color of the Display  

If the color or picture quality of the TV display needs to be adjusted, please do the following. 

1. Right click on the TV monitor. When a pop-up menu appears, select Individual 
Channel Setting. Or click Program List button  on the control panel and then click 

Individual Channel Setting button .  
2. When a dialog box appears, select Display tab. 

 
3. Then use ,   or the slider to adjust Brightness, Contrast, Hue, Saturation and 

Sharpness until you get an accurate color. 
4. If your device supports the 713x chip, you can choose color adjustment tab. Try the 

provided options to get desired color.  

 
5. If you just want to adjust color of one specific channel, select Individual Channel 

Setting and repeat step 3. To apply the converted settings to all channels, click Apply 
All button . 

6. Click Default button  if you want to revert to the factory settings. 

24 



 

4.1.5 Enhancing the Video Quality 

This function can reduce noise. Choose an appropriate option 
listed below. 

 Video Quality Enhancement Enable: Activate to improve the 
video quality.  

 Video Quality Enhancement Disable: Disable the video 
quality enhancement function.  

 Video Quality Enhancement Automatic: Automatically adjust 
video quality depending on the video screen size. 

OR, 

1. Right click on the TV monitor. When a pop-up menu appears, select Individual Channel 

Setting. Or click Program List button  on the control panel and then click Individual 

Channel Setting button . 
2. When a dialog box appears, select Video/Audio Settings tab.  
3. Choose a desired option from the Video Quality Enhancement drop-down list. 

 
4. If you just want to enhance video quality of one specific channel, select Individual Channel 

Setting and repeat step 3. To apply the converted settings to all channels, click Apply All 
button .  

5. Click Default button  if you want to revert the factory settings. 

4.1.6 Using the De-interlace Function 

The de-interlace function can remove the jagged edges of images in serial rapid movement. It is 
recommended using this function to ensure smooth and clear video images. 

1. Right click on the TV monitor. When a pop-up menu appears, select Individual Channel 

Setting. Or click Program List button  on the control panel and then click Individual 

Channel Setting button . 
2. When a dialog box appears, select Video/Audio Settings tab. 
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3. From the De-Interlace drop down list, try all the options to compare which can give you the 

best quality. 

4.2 Digital TV  
4.2.1 Scanning Channels 

If you didn’t complete the channel scanning when you first ran the application, please follow 
these steps to complete this procedure. 

1. Click the Setup button  and in the Setup dialog box, select an available Avermedia 
device in the left pane. 

 Note: 
Make sure that your Country/Region is correct. 
a. First, select an available AVerMedia device in the left pane. 
b. From the Region/Country drop-down list, select your country or region. 
c. Click Apply to save the settings. 

 

2. Then select Digital TV.  

3. Click New and the Program List dialog box will appear. Type in the desirable name and 
click OK. 
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4. Then Click Program Scan to start the scanning process. 

The application comes with a default frequency table therefore the application will use 
this table to search for active channels/programs. If you want to terminate the searching 
process, just click Stop. 

5. You can check the scanning progress from the progress bar. After scanning, the active 
TV/Radio channels will be listed inside the box. Click Apply to save the scanned channels. 

 

 Note: Digital Channels that are in red text indicate they are locked channels (eg. Adult channels).  

4.2.2 Scanning Channels (For Advanced Users) 

1. Click Advance located at right-lower corner in the Program Information section. Then 
the Advance Program Configuration dialog box will appear. 
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2. When there are channels missing from the channel memory, select All Frequencies or 
Single Frequency. 

 Note: All Frequencies Scanning may take you a while. Please be patient. 

3. Once you select Single Frequency, you need to specify the correct Frequency, for 
example 533000 (KHz), and Bandwidth. 

4. Then click Scan. 

5. After scanning, new active channels/programs will be memorized and listed 
in the left pane of the dialog box. 

6. Click Apply to save the scanned channels. 

4.2.3 Customize Video record settings 

To customize the video record settings, please do the following. 

1. Click the Setup button  and in the Setup dialog box, click on the Digital TV icon on 
the left pane. 

2. Select the Record Format option. 

3. Select recording type. You can use the default format or select New to create your own file 
format. Or you can choose Audio Only for sound recording.  
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4. Click Apply to save the setting and click OK to exit the current dialog box. To abort 
this operation, click Cancel. 

 Note: To determine the length of recording and to choose a destination folder in which 
to save the recorded audio, please refer to the section titled Record Settings in Chapter 6. 

4.2.4 Using the EPG Function  

Electronic Program Guide (EPG) is a service that allows you to check the next succeeding 
program schedule and even the program schedules of the whole week. If the EPG service is 
provided in your region/country, simply click the EPG button  to open the EPG window.  

First, select the desired program from the Program drop-down list and the EPG window will 
display the schedule for one week. Surely, you can also see the related information such as 
program name, time, and description about the program on the right pane of the window. 

In addition, when switching channels, the TV screen can show the current and succeeding 
program information. 

 

Our EPG window also allows you to preset a schedule for watching or recording programs. 

Just select your favorite programs and click Record button  or the Active TV 

Application button . And the system will execute your command on schedule. 

If you want to download the latest program schedule, please click the Update button . Click  to 
sort the EPG list by time or by channel. 
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 Note: To use EPG function, please make sure that the EPG GMT settings is correct.  

a. Click  on the control panel to see the Setup window. 

b. Click Digital TV on the left pane and press Advance located at right-lower corner. 

c. In the Advance Program Configuration window, click the desired channel. 

d. In the EPG GMT settings section, select Using customized EPG time to adjust the EPG 
time according to local time. Or, select Using standard EPG time to adjust the EPG time 
according to Greenwich Mean Time. 

 

4.2.5 Fine Tuning Color of the Display  

If the color or picture quality of the TV display needs to be adjusted, please do the following. 

1. Right click on the TV monitor. When a pop-up menu appears, select Individual 
Channel Setting. Or click Program List button  on the control panel and then click 

Individual Channel Setting button .  
2. When a dialog box appears, select Display tab. 

 
3. Then use ,   or the slider to adjust Brightness, Contrast, Hue, Saturation and 

Sharpness until you get an accurate color. 
4. If you just want to adjust color of one specific channel, select Individual Channel 

Setting and repeat step 3. To apply the converted settings to all channels, click Apply 
All button . 



 

5. Click Default button  if you want to revert to the factory settings. 

4.2.6 Enabling Subtitle Function 

If your local broadcasters provide subtitle service, you can view those text by doing the followings: 

Right click the TV screen, point to Subtitle and choose the desired language.  

To hide the subtitle, please right click the TV screen, point to Subtitle and choose Close. 
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4.3 Adding and Deleting Program Lists 
Selecting a program list allows you to switch between the channels of the selected program 
list only when pressing the Channel Up/Down button. If you want to add or delete a 
program list, do the following: 

To add a new program list:  
1. Click the Setup button  and in the Setup dialog box, click the Analog TV or Digital 

TV icon on the left pane. 

2. Click New and the Program List dialog box will then 
appear (as shown at right).  

3. Type in a program list name and click OK. 

4. Click Program Scan and click Yes to continue the 
scanning process. 

5. Available channels will then be listed in the Program Information and now you can 
delete the unwanted programs by clearing the check box.  

 

6. Click Apply to save the setting and click OK to exit the current dialog box. Or you can 
click Cancel to revert to the original settings.  

OR, 

If you don’t want to scan programs every time creating a new program list, you can use 
Copy function. 

1. From the program drop-down list, select the program list that you 
want to duplicate.  

2. Click Copy and the Program List dialog box will appear. 

3. Type in desired name and click OK. 

4. Finally, just like the steps described above, clear the check mark next to the 
unwanted channels. 

To delete a program list: 
1. Click the Setup button  and in the Setup dialog box, click the Analog TV or Digital 

TV icon on the left pane. 
2. From the program drop-down list, select the name of the group that 

you want to remove. 
3. Click Delete to remove the selected program list. 
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4.4 Selecting a TV/Radio Channel  
There are three ways of switching between TV/Radio channels: 

◆Click the Channel Up/Down buttons (  on the TV monitor window or  on 
the Control Panel) repeatedly until reaching your desired channel.  

◆Click  to open the Numeric Panel (as shown at right). Then click on 
the Numeric buttons to get your desired channel number. 
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OR, 

◆Click the Program List button . When the Program Panel appears, 

select the Display Mode button . Choose the desired program list from the 
drop-down list and then double-click on the desired channel.  

 

 Note: Locked channels (eg. Adult channel) are in red text.  

4.5 Creating Channel Groups  
To add a new channel group: 

1. Click the Program List button  on the control panel. 

2. Click the Setup button . 

 



 

3.  When a dialog box appears, click New button .  
4. Specify the desired name in the text box. 

 
5. Hold down Shift or Ctrl key and click the channels from the list to select your own channel line up, 

then click  to add your selection to the desired group. Or drag the selected channels and drop them 
to the desired group. 

6. Click Save  to save the settings or click Cancel  to abort without saving. If you want to 

delete the unwanted group, simply click Delete  

4.6 Adjusting Volume 
On the Control Panel, click and drag your mouse over the Volume meter to 
increase or decrease the volume level. You can also press the + / – keys on the 
numeric keypad to adjust the volume.  

 

OR,  

1. Right click on the TV monitor. When a pop-up menu appears, select Individual 
Channel Setting. Or click Program List button  on the control panel and then 

click Individual Channel Setting button . 
2. When a dialog box appears, select Video/Audio Settings tab. 
3. Use  and  next to the icon  to adjust the system volume or the device volume. 
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4. If you just want to adjust individual volume level, select Individual Channel Setting 
and repeat step 4 to increase or decrease volume. 

5. To apply the converted settings to all channels, click Apply All button .  

6. Click Default button  if you want to revert the factory settings. 

4.7 Specifying a Channel Name or Description 
To assign a channel name or specify a description: 

1. Click the Setup button  and in the Setup dialog box, click the Analog TV or 
Digital TV icon on the left pane.  

2. Under the Name column, double-click the text box of the channel you want to assign a 
name or description. 

3. Type in the channel name or description, then press Enter. 

 

 OR, 

1. Click the Setup button  and in the Setup dialog box, click the Analog TV or Digital 
TV icon on the left pane. 

2. Click Advance located at right-lower corner in the Program Information section. Then 
the Advance Program Configuration dialog box will appear. 

3. In the dialog box, select the channel/program you want to assign a name or description.  

4. In the Name text box, type in the desired name or description. Press Apply to save the 
settings and click OK to exit the dialog box. Or you can press Cancel to abort without 
saving.   

 

4.8 Modifying a program list name 
You can change a program list name easily. To rename a program list, follow the steps 
described below: 
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1. Click the Setup button  and in the Setup dialog box, click Analog TV or Digital TV 
icon on the left pane. 

2. Click Advance located at right-lower corner in the Program Information section. Then 
the Advance Program Configuration dialog box will appear.  

 

3. Type the desired name in the Program List Name text box. 

 

4. Press Apply to save the setting and click OK to exit the dialog box. Or press Cancel to 
abort the saving. 

4.9 Removing Unwanted Channels 
If you want to exclude unwanted channels from your channel list, do the following: 

1. Click the Setup button  and in the Setup dialog box, click the Analog TV or Digital 
TV icon on the left pane. 

2. Click Advance located at the right-lower corner in the Program Information section. 
Then the Advance Program Configuration dialog box will appear. 
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3. In the Program Information section, select the unwanted channel and then click Delete. 
This channel will be removed and that means you won’t be able to access these 
programs anymore. 

 

OR, 

If you just want to skip a certain channel, do the following: 

1. First, select the unwanted channel in the Program Information section. 

2. Clear the Enable check box so that you will not access that channel 
when you press Channel Up/Down buttons.  

3. However, you can still see the channel in your program list. If you want to watch that 
channel again some day just select the Enable check box. 
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4.10 Using the OverScan Function 
On some broadcast channels, you might see 
distorted lines or black spaces on the top, sides, 
or bottom of the screen.  These video artifacts 
derive from the source signal, and can be masked 
using the OverScan feature. 

To hide the edges of the picture:  

 Right-click on the TV Monitor and choose 
OverScan to enable it. 

OR, 

1. Right click on the TV monitor. When a 
pop-up menu appears, select Individual Channel Setting. Or click Program List 

button  on the control panel and then click Individual Channel Setting button . 
2. When a dialog box appears, select Video/Audio Settings tab. 

 
3. Specify an appropriate number (0~50) in the Overscan text box to get a better quality 

image. 
4. If you just want to apply OverScan setting to one specific channel, select Individual 

Channel Setting and repeat step 4. 

5. To apply the converted settings to all channels, click Apply All button .  

6. Click Default button  if you want to revert the factory settings. 

You can see the difference from the pictures below: 

Before using OverScan function After using OverScan function 
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4.11 16-Channel Preview 

 

The 16-channel preview function can
can see clearly which TV p

 display 16 TV channels on-screen at the same time. You 
rograms are currently showing on these channels. 

To v pre iew the channels:  

1. Click  to open the Numeric Panel. 

2. Click the 16-Channel Preview button. 

3. The screen will be gradually filled up with 16 TV channels
starting from the currently selected channel.  

Select a channel and press the numeric button “5” on the 

, 

4. 
 

5. ls 

n or press ESC to return to the originally selected TV 

4.1

․ To als, click the Radio Source button 

remote control to view it only and freeze the other channels. If you want to continue
to display other channels just press C letter on the keyboard. 

To display a channel on the TV Monitor window, select any one of the 16 channe
on-screen and double-click on that channel, or use the arrow ↑, ↓,  ←,  → button of 
your keyboard and then press Enter. You will then be tuned in to that channel.  

6. Or, click the right mouse butto
channel. 

2 Changing Signal Source 
There are two ways to change signal source: 

 switch between TV and radio / external video sign  

or Video Source button  on the control panel. 

․ Right click on the left pane of the control panel and a pop-up menu appears. Choose the 
desired signal source. 
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4.13 Sound Controlling (Optional) 
This function provides a variety of sound effects.  

1. Right click on the TV monitor. When a pop-up menu appears, select Individual 
Channel Setting. Or click Program List button  on the control panel and then click 

Individual Channel Setting button . 
2. When a dialog box appears, select Sound mixer tab. 

 
3. Choose the desired sound effects from the drop-down list. 
4. Then use ,  or the slider to control the “Stereo”, “Bass” and “Treble” level. 
5. If you just want to adjust sound effects of one specific channel, select Individual 

Channel Setting and repeat step 4 and step 5. 

6. To apply the converted settings to all channels, click Apply All button .  

7. Click Default button  if you want to revert the factory settings. 
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Chapter 5 FM Radio 
5.1 FM Radio Controls 

Click the FM Radio button to listen to your favorite radio station programs. 

Use the following button controls for selecting FM radio channels, adjusting volume, 
scanning FM channels, recording radio programs and more. 

To change back to live TV, click the Radio Source button. 

 

(This picture is only for reference) 

1.  Signal Status / Enable or disable Repeat Play 14. Schedule 
2.  Signal Strength 15. Play List 
3.  Backward 16. Show/Hide Numeric Panel 
4.  Channel Loop 17. Video Source 
5.  16-Channel Preview 18. Record 
6.  Channel Up/Down 19. TimeShift / Pause 
7.  Mute 20. Next File 
8.  Setup 21. Previous File 
9.  TEXT/RDS(It may vary depends on your 

device and your living area.) 
22. Stop 

10.  Forward 23. Play / Pause 
11.  Radio Source 24. Volume Control 
12.  Program List 25. Help 
13.  Audio Mode 26. Numeric Buttons 

5.2 How to Auto Scan FM Radio Channels 
If this is your first time to use FM radio, perform auto scan to search and memorize active FM 
radio stations in your area.  

To auto scan FM radio stations: 

1. Click the Setup button  and in the Setup dialog box, select an available AVerMedia 
device in the left pane. Then select FM Radio. 
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2. Click New and the Program List dialog box will appear. Type in the desirable name and 
click OK. 

 Note: The system will assign a default name (FM-Radio) if you don’t create a new program 
list before scanning. 

 

3. Click Scan. All active channels will be automatically scanned and memorized. 

4. To terminate the scanning, click Stop. 

5. Click Apply to save the setting and click OK to exit the current dialog box. To abort the 
setting, click Cancel. 

5.3 Manually Scanning Specific FM Channels 
Instead of scanning all channels, you can choose to manually scan one or a few channels only. 
To do this, follow these procedures.  

To manually rescan specific FM radio channels: 
1. Click the Setup button  and in the Setup dialog box, click FM Radio icon on the left 

pane.   
2. Enter the channel frequency that you want to start scanning in the text box. 

 
3. Select 0.01 MHz, 0.05MHz or 0.1MHz as your tuning increment.  

4. Click  to scan upward or  to scan downward from the selected channel frequency. 
The scanning will stop when the application finds the closest ACTIVE FM frequency. 

5. Or click  or  to increase/decrease the frequency to search your preferred channel. 
6. Click the Modify button if you’d like to keep the newly scanned frequency. 

5.4 Selecting a Channel 
To select a channel: 

1. Click  to open the Numeric Panel. 

‧ Click on the Numeric buttons to select a channel. 

‧ Click the Channel Up/Down button repeatedly until reaching your desired channel. 

OR, 

2. Use the numeric keys on your keyboard to select a channel. 
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5.5 Adjusting Volume 
On the Control Panel, click and drag your mouse over the Volume meter to 
increase or decrease the volume level. You can also press the + / – keys on the 
numeric keypad to adjust the volume.  

 

OR,  

1. Right click on the TV monitor. When a pop-up menu appears, select Individual 
Channel Setting. Or click Program List button  on the control panel and then click 

Individual Channel Setting button . 

2. When a dialog box appears, select Video/Audio Settings tab. 

3. Use  and  next to the icon  to adjust the system volume or the device volume. 

 

4. If you just want to adjust individual volume level, select Individual Cnannel Setting 
and repeat step4 to increase or decrease volume. 

5. To apply the converted settings to all channels, click Apply All button .  

6. Click Default button  if you want to revert the factory settings. 

5.6 Skipping Unwanted Channels 
If you want to exclude undesirable channels from your FM channel list, do the following: 

1. Click the Setup button  and in the Setup dialog box, click FM Radio icon on the left 
pane.  

2. In the Program column, click the unwanted channel. The check mark will be removed, 
indicating that the channel will be excluded from your channel list and that you won’t 
be able to access and hear them through the Channel Up/Down button. 
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5.7 Adding a Radio Frequency  
If the desired channel cannot be found through scanning, follow the instructions below. 

1. Click the Setup button  and in the Setup 
dialog box, click FM Radio icon on the left 
pane. 

2. Specify the correct frequency in the text box 
(as shown at right) and click Save.  

 

5.8 Modifying a Radio Name 
You can manually modify any exiting FM radio channel. 

1. Click the Setup button  and in the Setup dialog box, click FM Radio icon on the left 
pane. 

2. Double click on Name column of the existing FM channel which you want to modify. 

3. Enter the name or description you want in the provided text box and then press Enter. 

 

4. To modify more channels, repeat step 2 to 3. 

5. Click Apply to save the setting and click OK to exit the current dialog box. 

5.9 Adding and Deleting Program Lists 
Selecting a program list allows you to switch between the channels of the selected program 
list only when pressing the Channel Up/Down button. If you want to add or delete an FM 
channel group, do the following: 

To add a new program list:  
1. Click the Setup button  and in the Setup dialog box, click FM Radio icon on the 

left pane. 
2. Click New and the Program List dialog box appears. Type in a program name and 

click OK. 
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3. Now you can start to scan FM radio channels and manage the scanned FM data for this 
new program list. For more information, refer to How to Auto Scan FM Radio 
Channels. 

4. To add more program lists, repeat steps 2 to 3. 

To delete a program list: 
1. Click the Setup button  and in the Setup dialog box, click FM Radio icon on the 

left pane. 
2. From the drop-down list, select the name of the program list that you want to remove.  
3. Click Delete to remove the selected program list. 

5.10 Creating Channel Groups 
To add a new channel group: 

1. Click the Program List button  on the control panel. 

2. Click the Setup button . 

3. When a dialog box appears, click New button .  
4. Specify the desired name in the text box. 

 
5. Hold down Shift or Ctrl key and click the channels from the list to select your own channel line up. 

Then, click  to add your selection to the desired group. Or drag the selected channels and drop 
them to the desired group. 

6. Click Save  to save the settings or click Cancel  to abort without saving. If you want to 

delete the unwanted group, simply click Delete  

5.11 Customizing Audio Recording Settings 
To customize audio recording settings: 

1. Click the Setup button  and in the Setup dialog box, click FM Radio icon on the left 
pane. 

2. Then select Record Format. You can choose default format as your audio file format. 
Or, you can click New to create your own file format. For file format description, 
please refer to the section titled Customize Video Record Settings in chapter 3.1. 
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3. In the Format dialog box, select the audio file format. 

 
4. Enter the desired format name or description in the Format Name text box. 
5. Click Next. In the Video dialog box, select the desired audio format. 
6. Click Finish. 
7. If you want to change the setting of your own file format, click Modify or you can 

click Delete to remove the unwanted file format that you created earlier. 
8. Click Apply to save the setting and click OK to exit the current dialog box. To abort 

this operation, click Cancel. 

 Note: To determine the length of recording and to choose a destination folder in which 
to save the recorded audio, please refer to the section titled Recording Setting in Chapter 6. 

5.12 Sound Controlling (Optional) 
This function provides a variety of sound effects.  

1. Right click on the TV monitor. When a pop-up menu appears, select Individual 
Channel Setting. Or click Program List button  on the control panel and then click 

Individual Channel Setting button . 
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2. When a dialog box appears, select Sound mixer tab. 

 
3. Choose the desired sound effects from the drop-down list. 
4. Then use ,  or the slider to control the “Stereo”, “Bass” and “Treble” level. 
5. If you just want to adjust sound effects of one specific channel, select Individual 

Channel Setting and repeat step 4 and step 5. 

6. To apply the converted settings to all channels, click Apply All button .  

7. Click Default button  if you want to revert the factory settings. 

5.13 Viewing RDS Information (Optional) 
RDS (Radio Data System) is an international standard for transmitting the digital data along 
with FM Radio signal. An RDS-capable radio can display name of the station, program types, 

local traffic information or commercials, etc. To view RDS information, press  on the 
control panel. 
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Chapter 6 TimeShift  
The TimeShift function performs background recording of a TV/Radio program, and lets you 
return and watch any part of the recorded program. At the same time, the live TV/Radio 
program continues to be recorded and played back so you won’t miss any part of the show. 
You can also advance forward to skip commercials or rewind to replay scenes one more time. 

6.1 TimeShift Controls 
Use the following button controls in the Control Panel to start recording a live program, play 
back the program from where you left off, advance forward, rewind, and more. 

 

 BUTTON FUNCTION 
1 Backward Click to move backward in intervals 
2 Playback Seek Drag the slider tab to move to any part of the recorded program 
3 Volume Drag your mouse up/down to increase/decrease the volume level. 
4 Mute Turn off the sound. 
5 Setup Allows you to: 

*Autoscan channels. 
*Create channel groups. 
*Configure snapshot settings. 
*Customize record settings. 
*Customize the TimeShift function. 

6 Forward Click to skip forward in intervals 
7 TimeShift / Pause Click to perform background recording of the live program and play it back 

simultaneously. / Click to temporarily freeze the playback. 
8 Stop Click to terminate recording and return to the live program 

6.2 Customizing TimeShift Settings 
Before you start using the TimeShift function, first check its recording settings to see if they 
fit your needs. 

To check and customize settings: 

1. Click the Setup button  and in the Setup dialog box, click the Storage icon on the 
left pane. You will then see the following settings. 
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2. By default, TimeShift performs recording of the TV program by creating a temporary 
video file and deletes this file once you click the Stop button. If you want to save the 
video file, select the Keep TimeShift Files check box. 

3. In the Record section, you can determine your filename format, recording time, file 
size and destination folder. 

4. Click Apply to save the new settings and click OK to exit the current dialog box. Or, 
click Cancel to use the original settings. 

To customize the file quality: 

1. Click the Setup button  and in the Setup dialog box, click the Analog TV / Digital 
TV / FM Radio icon on the left pane.  

2. Then click Timeshift icon. 

3. Here you can determine the video size, bit rate and sample rate. Please be noted the 
items may vary depending on the device you use. 

 

4. Click Default if you want to revert to the factory settings. 
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6.3 Using the TimeShift Function 
To pause the live program: 

1. Click the TimeShift button  on the Control Panel. The application will begin to 
record the program. 

2. When you want to rewind, use the Playback Seek slider bar to move back to the part 
you want to watch or listen again. Click and drag the slider tab to the left until you 
see the part of the show you wish to watch or listen, then release the mouse button. 

 

3. You can also click the Backward button  to move backward in fixed intervals until 
you reach the part where you left off. 

4. To advance forward and skip some parts of the recording (for example TV 
commercials), drag the slider tab to the right. You can also click the Forward button 

 to move forward in fixed intervals. 

5. To temporarily pause the playback, click the Pause button . Click Pause button 
again to resume. 

6. To return to real-time viewing of the live program, click the Stop button . This 
switches off the TimeShift function and returns you to live program. 

50 



 

Chapter 7 DVR 
You can use your computer as a digital video recorder, and record your favorite TV programs 
or capture video from an external source to your hard drive. You can also divide the recording 
files in proper sizes to facilitate burning onto removable optical media, such as CD-R and 
DVD discs. 

7.1 DVR Controls 
Use the following button controls for recording and video playback. 

 

(This picture is only for reference) 

 BUTTON FUNCTION 
1 Backward Click to move backwards in intervals 

2 Playback Seek Drag the slider tab to move to any part of the recorded file. 

3 Volume Drag your mouse up/down to increase/decrease the volume level. 

4 Mute Turn off the sound. 

5 Setup Allows you to: 
*Autoscan channels. 
*Create channel groups. 
*Configure snapshot settings. 
*Customize record settings. 
*Customize the TimeShift function. 

6 Forward Click to skip forward in intervals. 

7 Play List Click to create a playlist of video files to play back. 

8 Record Click to start recording. 

9 Play Previous/Next File Click to go to the previous/next video file in the playlist. 

10 Stop Click to stop recording or playback. 

11 Play /Pause Click to play back / Click to temporarily freeze the playback. 

7.2 Recording Settings 
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Before recording, check if the settings meet your needs.  

1. Click the Setup button . In the Setup dialog box, click the Storage icon on the left 
pane. 

2. By default, the system is set the recording “Date” and “Time” as the file name format. 
To create your own file name format, please click Custom. 

3. The Duration option allows you to specify a recording duration otherwise the system 
will record the largest clip that your hard drive can accommodate. 

4. This application lets you to divide the recording files into smaller parts for burning 
onto removable optical media, such as CD-R (650 MB) and DVD (4096 MB) discs. 
Enable the Split File Size option and select the appropriate video file size from the 
drop-down list so that each video file will not exceed the limit. Or you can choose 
Custom to assign the file size you want. 

5. Determine the destination folder. Click  to choose a folder you want. 

6. Click Apply to save the settings and click OK to exit the current dialog box. To abort 
this operation, click Cancel. 

7. To determine the file format, please refer to the section titled Customizing Video 
Recording Settings in chapter 3 or Customizing Audio Recording Settings in chapter 4.  

 Note: To hide the sound of the TV program when recording, click the Mute button 
 on the Control Panel. 

7.3 Using the Recording Function 
To record a TV/Radio program that you want, do the following: 

1. Click the Record button  on the Control Panel. 

2. You can click the Stop button  to terminate the recording and return to live TV program. 

7.4 Playing the Recorded Programs 
Each TV program that you recorded will be saved as a video file in the assigned destination 
folder. 

To play back the recorded video files: 

Click the Play button  to play back. 

OR, 

(1) Click the Play List button , and you may see some recorded video files are listed at the 
top right pane of the Playback List window. 

(2) To add more video files to the playback list, first navigate the file on the left pane to find 
the folder that contains the desired video files. When you have located the folder, the 
media files will then be displayed on the right top pane. Select the files that you want, 
then click Insert, or click Insert All to add all media files in the folder to the playback 
list. 
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(3) To delete files from the Playback List, select them from the list in the bottom right pane 
and click Delete, or click Delete all to delete all files in the playback list. 

 

7.5 Picture-in-Picture Display 
With the picture-in-picture window feature, you will be able to play 
back recorded video files, and at the same time, watch live TV. 

To enable PIP function, right click the TV monitor, select PIP and 
choose desired position of the PIP window.  

Position Description 

Top-left Corner /  Display the PIP window on the top-left corner 

Top-right Corner /  Display the PIP window on the top- right corner 

Bottom-left Corner /  Display the PIP window on the bottom-left corner 

Bottom-right Corner /  Display the PIP window on the bottom-right corner 

Movable /  Resize the PIP window and separate it from the main window 

By default, you will be able to play back recorded video files on the main window, and at the same 
time, watch live TV on the PIP window. If you want to switch the video playback to the PIP window 
and the live TV to the main window, press the button . You can also press the button  to fix the 
size of the PIP window and the distance between the main window and the PIP window. To exit the 
PIP window, press .  
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Chapter 8 Image Capture 
While you watch TV or a recorded video on your PC monitor, you can use the AVerTV 6 application 
to capture images for your documents, presentations or web pages. 

8.1 Before Capturing 
Before you start capturing images, first set the destination folder for saving captured images. 

Click the Setup button , and select the Snapshot icon on the left pane. Then click  to 
choose a folder where you want to save captured images. 

8.2 Capturing a TV/ Video Image 
To capture a still image, click the Snapshot button on the Control Panel. The Album 
will then appear, displaying thumbnails of the captured images. 

 

 BUTTON 
1 Wallpaper 

2 Save as 

3 Remove 

4 Remove All  

 

To capture another image, click the Snapshot button on the Control Panel again. New 
thumbnails will be added to the Album as you capture more images. 

By double-clicking on the thumbnails, you can view images in a full-screen window with 
default image viewer. 

To display the captured image as your desktop wallpaper :  

1. Select the thumbnail of the desired image and then click the Wallpaper button . 

2. The selected image will be displayed as your desktop wallpaper, the background of 
your desktop. 

To save the captured image: 

1. Select the thumbnail of the image and then click the Save As button . The Save 
As dialog box will then appear. 
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2. From the File Format drop-down menu, select the format for saving the captured 
image. 

3. Choose the Color format. The options here depend on the file 
format you choose. 
• Choose 24-bit to capture image in 16M colors. 
• Choose 8-bit to capture image in 256 colors. 

4. Click Browse to scan for folders and select a destination location for saving the 
image. Then specify a file name for saving the captured image. 

 

5. Choose the image size. 
• In the Size section, select the Standard option and choose a desirable image 

size from the drop-down list. 
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• If you want to set your own image size, select Customize and enter the image 
Width and Height. If you want to maintain relative width and height, select the 
Keep Ratio option. Choose a measurement unit from the Unit drop-down list. 
You can specify any image size you want. The maximum capture size can be 
1600×1200. 

 

6. Click OK to save the image. Click Cancel if you do not want to save the image. 

8.3 Multiple Image Sequence Capture 
To capture a continuous sequence of images, do the following: 

1. Click the Setup button . In the Setup dialog box, click the Snapshot icon on the 
left pane. 

 

2. In the Number of Pictures box, specify the number of images you want to capture. 

3. In the Interval Time box, specify the interval between captures. For instance, if you 
specify 10 seconds, an image will be captured every 10 seconds. 

4. On this page, you can choose the file format and destination folder, file name format 
and image resolution in advance. 

5. Click Apply to save the new settings and click OK to exit the current dialog box. Or 
Click Cancel if you do not want to change the settings. 

6. Click the Snapshot button  on the Control Panel to start capturing. 
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Chapter 9 Teletext (PAL/SECAM only) 
Teletext makes TV viewing a unique experience. It allows you to view teletext broadcasts 
from your television programs to get the most updated information on TV Schedules, News, 
Stock Market Prices, Concert & Theatre information and so on. Teletext information may not 
be available if there is no such service provided in your region or country. 

9.1 Customize the Display Mode  

1. Click the Setup button  and in the setup dialog box, click the Teletext icon in the left pane. 

2. From the Display Mode drop-down list, choose Other Window Display to open a new Teletext 
window or choose Main Window Display to overlay the Teletext window on the TV monitor. 

3. Select the Transparent check box to make the Teletext window transparent. 

 
(This picture is only for reference) 
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9.2 Overview 
Click the Teletext button  on the control panel to open the Teletext application as shown 
below. For more information about Teletext, please see below in this chapter. 

1

2

3

4

5

 

 BUTTON FUNCTION 
1 Menu Bar This contains the names of the available drop-down list option menus. To 

access any of the menu items, simply click on it or hold down Alt and press 
the first character of each item. 

2 Toolbar It includes buttons that gives quick access to perform certain frequently used 
functions from the Menu Bar. 

3 Status Bar Status bar is located at the lower left corner of the window. It contains a short 
text message or explanation of the currently selected menu command. 

4 Title Bar This is located at the top of the window. It contains the current displayed page 
number or in hexadecimal page number of an active window. 

5 Teletext 
Browser 

Teletext information is displayed in this area. The information would be the 
TV schedules, news, stock market reports, concert & theater information and 
so on. 
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9.3 Toolbar Buttons  

  

t 

Lock Sub page  
Locks the current sub page. The upcoming transmitted sub pages will be stored in the Teletext 
Cache for later use.  

Previous Sub page/ Next Sub page 
Switches to the next or the previous sub page.  

Home (Ctrl+H) 
Connects to the Teletext home page which always goes to page 100, but page 100 may not be 
the primary Teletext source. 

Previous Page (-) / Next Page (+)  
Displays the preceding or the succeeding Teletext in hexadecimal page number. 

History Back / History Forward 
Retrieves the previous page in the history list.  

Moves a page forward in the history list. The command is usable after one or more back steps 
in the history list. 

TV Scale  
Changes the proportion of the Teletext window to 4 by 3. 

Always On Top 
Makes Teletext Window float over the top of other applications. 

Teletext File  
Switches between the Teletext file which is opened from the previously saved file and the 
most recent Teletext information.   

9.4 LED Lamp
Different LED color indicates different state. 

Left LED Lamp:  
Gray -- The system does not receive the Teletext broadcast data.  
Green -- The system is receiving the Teletext broadcast data. 
Right LED Lamp:  
Green -- The cache in Teletext application is running less than 90% usage.  
Yellow -- The cache in Teletext application is running over 90% usage. 
Red -- The cache in Teletext application is running out. 

9.5 Using Teletex
The following briefly describes how to use the Teletext feature.  

Teletext Page 
There are two page numbers displayed on the first line of each Teletext page. The page 
number on the left is the page number that you have selected or keyed in. The other one in the 
middle of line is the page number of the currently displayed Teletext data. 
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The newly selected page number will appear on the upper left corner of the page. Sometimes, 
this may take a while to retrieve the newly selected Teletext page.  There will be no changes 
on the page when there is no page data transmitted with the number you have selected. 

A Teletext page can be selected with one of the following methods: 

 Key in the hexadecimal or Teletext page number using the numeric buttons of your 
keyboard or AVerMedia TV remote control. 

 Press the + (positive) or – (negative) button to move to the succeeding or preceding 
Teletext page. 

Copying a Teletext Page 
1. Simply click and drag over the text or the area that you want to copy using the mouse.  

2. Choose Copy from the Edit menu (Alt+E, C) or press Ctrl+C.  

3. You can then paste the contents of the Teletext page in TXT or BMP format to a 
document you are working with. 

Saving a Teletext Page 
Some Teletext pages include a number of subpages. If the file has subpages, Teletext will also 
save the existing subpages. 

1. A Teletext page can be saved using one of the following ways: 

● To automatically save the file using the displayed Teletext page as the filename and 
the default file format, choose Save from the File menu or press Ctrl+S.  

● To save the file by specifying your own filename and different file format, choose 
Save As from the File menu or press Ctrl+A. 

2. A save as dialog box will appear: 

 
 

3. Select the file format to use for saving the Teletext page. You can save the Teletext 
page in : 

  TXT Text file format 
  BMP Windows bitmap file format 
  TLT Teletext file format 
  TLX Teletext file format 
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4. Enter a filename and click OK. 

Opening a Teletext Page 
1. Choose Open from the File menu or press Ctrl+O. 

2. From the Open dialog box, select the file containing the teletext page you want and 
click Open. 

 
 

Opening Another Teletext Window 
To open another teletext window, choose New Window from the File menu or press Ctrl+W. 

Closing the Active Teletext Window 
Choose Close Window from the File menu or press Ctrl+L to close the active Teletext page 
window. 
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Chapter 10 Scheduler  
The Scheduler allows you to create a list of preset schedules for watching and recording 
your favorite TV/Radio programs. You can set the day and time to record the TV/Radio 
program and specify the length of recording. 

To run this application, click the Schedule button  on the Control Panel. Then the 
Scheduler dialog box will appear. 

1

2  

 

 
 BUTTON 

1 Current Time 

2 Selected Schedule  

The check box next to the Program column (as shown at right) 
indicates the schedule will be executed at a preset time. Once the 
application starts to execute a scheduled task, the system will clear the 
check mark automatically. If you want to skip the schedule temporarily, 
just clear the check box.

Schedule Management 

This displays a list of preset schedules you have created.  

Modify  

Select a preset schedule and click this button to make changes.  

Delete  

Click this to delete selected schedule. 

Delete Expired Schedule  

Click this to delete the expired schedule. 

Delete All  

Click this to delete all schedules. 

10.1 Adding Schedules 
To create a new schedule: 

3. Click the Add button . 

4. The following dialog box will then appear:  
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5. Type the desired name in the Schedule Name text box. 

6. From the Function drop-down list, select Activate AVerTV to watch a TV program or 
listen to a radio broadcast. Otherwise, select Record to save a TV/Radio program for 
future viewing/listening. You can also select Silent Record which means the system 
will perform background recording instead of activating the TV/Radio program. If you 
want to schedule a task to enable Timeshift function, select Timeshift. 

  

 Note: If you select Silent Record, when the application is performing the 
recording task, the icon  will appear on the task bar (the lower right corner of 
the screen). To immediately watch or listen to the TV/FM program which is 
being recorded, just double-click this icon.  

7. In the After Record-Schedule, it automatically switches to the selected power control 
mode when the schedule recording is completed. Choose an appropriate power control 
status listed below: 

 
‧ Watch TV: Switch to real-time TV mode. 
‧ Exit: Turn off the AVerTV Application. 
‧ Stand By: Turn off your monitor and hard disks. 
‧ Hibernate: Save everything and then turn off your computer. 
‧ Shut Down: Turn off your computer. 

 Note: If you choose Watch TV from the drop-down list, after completing the Silent 
Record task, the icon  will appear on the task bar (the lower right corner of 
the screen). Just double-click this icon, you can immediately watch live TV or 
listen to the radio. 
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8. In the Program Settings section, select the desired device, video source, group and 
channel you want. 

9. Set the schedule to tune in live TV or to perform recording. You can set the schedule on 
Once, Daily or Weekly. 

‧ Choose Once to perform schedule at a preset day and a preset time. 
‧ Choose Weekly to perform schedule every week, at a preset day and time. 
‧ Choose Everyday to perform schedule everyday at a preset time. 

10. If you choose Activate AVerTV in step 4, click Insert 
to complete the settings. If you choose Record or Silent 
Record, you need to do the following. 

11. Click the Advance icon. 

12. In the Record Setting section, you can determine the 
file format, recording duration, file size, destination 
folder and audio mode. 

13. Click Insert to save the new schedule or click Cancel 
to abort without saving. 
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Chapter 11 Hot Keys   
You can use the default hot keys or create your own hot keys. 

To re-define the shortcut keys: 

1. Click the Setup button . In the Setup dialog box, click the Keyboard icon on the left pane. 

2. Choose the signal status from the Category drop down list. 

3. Choose a command that you want to specify a new hot keys. 

4. Assign hotkey combination to the command that you use most often and then click Assign. Or you 
can click Remove to delete hotkeys. 

 
(This picture is only for reference) 

5. Click Default if you want to revert to the factory setting. 

6. Click Apply to save settings or click Cancel to abort without settings. 

Note: It is recommended to use an unassigned key to use as your new keys. 
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The following is the default definition: 

Hot Key Description Function 
UP/DOWN ARROW Channel or Frequency 

Up/Down 
Press to go to the next upper/lower 
TV/Radio channel. 

L Channel Loop Press to go to the previously accessed 
TV/Radio channel.  

NUMERIC KEYS Select Channel  Use NUMERIC KEYS to directly enter 
the TV/Radio channel number. 

ESC Stop 
or, Change back to Normal 
View 

Stop (playback, recording, TimeShift, or 
16-Channel Preview). Or change full 
screen back to normal view. 

F1 Help Open the Users Manual. 

F2 Minimize Minimize the application and an icon will appear 
in the notification area. To return to the previous 
screen, double click the icon again. 

F5 Full Screen Show TV/Video in full screen.  

F6 Display (OSD) information Display information on the TV monitor. 

F8 16-Channel Preview Press to perform 16-Channel Preview 
function. 

+/- (on your numeric 
keypad) 

Volume Press to increase or decrease the volume 
level. 

LEFT/ RIGHT 
ARROW 

Rewind/  
Fast Forward 

Press to rewind or fast forward (for 
playback and TimeShift). 

A Audio Mode  Choose between available languages. 

D Show/Hide TV Monitor Panel Toggles between showing and hiding the 
panel on the TV monitor window. 

M Mute Turn off/on the sound. 

Ctrl + N Play Next File Play the next file in the playlist. 

Ctrl + P Play Previous File Play the previous file in the playlist. 

Ctrl + R Record Start recording. 

P Play / Pause Play/Pause (for playback, recording, and 
TimeShift). 

Ctrl + S Snapshot Capture an image (or a continuous 
sequence of images). 

Ctrl + T TimeShift Enable the TimeShift function. 

Insert  Transparent Make Teletext window transparent. (Only 
available for Teletext overlay mode.) 

Page Up Previous page Go to the preceding Teletext page. 

Page Down Next page Go to the succeeding Teletext page. 

Home Home page Go the Teletext home page. 



 

Chapter 12 Customer Service  
The AVerTV application provides a convenient tool, which allows users to contact 
AVerMedia’s customer service department easily via our website. Please make sure that you 
have already connected to the Internet.  

 To contact the customer service: 

1. Right-click on the TV monitor window. When a menu list 
pop-up, choose About (as shown at right).  

2. When a information dialog box appear, select the office in 
your area from the drop-down list.  

 

3. Click  to connect to our website. Then click  to exit the current dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

www.avermedia.com 
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